# Table of Contents

**Preface** ................................................................................................................................. 1  
Conventions Used in this Guide .............................................................................................. 1  
Variables ...................................................................................................................................... 1  
Notes ........................................................................................................................................... 2  
Typographical Conventions ........................................................................................................ 2  
Getting Help ............................................................................................................................... 3  
Documentation and Learning Resources ..................................................................................... 3  
Technical Support ....................................................................................................................... 3  
Community ................................................................................................................................. 3  
Blackboard Collaborate Product Feedback .................................................................................. 3  

**Chapter 1 Getting Started** .................................................................................................. 5  
System Requirements .................................................................................................................. 5  
Blackboard Collaborate Web Conferencing ................................................................................. 5  
Operating System ....................................................................................................................... 6  
Java Web Start ............................................................................................................................. 6  
Screen Readers ............................................................................................................................. 6  
Java Access Bridge ...................................................................................................................... 6  
Getting Ready for a Blackboard Collaborate Session ................................................................. 7  
Using this Guide .......................................................................................................................... 7  


Chapter 2 The Blackboard Collaborate Web Conferencing Room ........................................11
  The Content Area Modes .......................................................................................13
  Managing Panels and Windows ...........................................................................14
    Working with Windows .........................................................................................14
    Working with Panels ..........................................................................................16
Chapter 3 Navigation .........................................................................................19
  Keyboard Navigation ............................................................................................20
    Navigating Between Modules ...........................................................................20
    Navigating Between Elements ..........................................................................20
    Navigating Within a Toolbar of a Module Window ............................................21
    Navigating Within Drop-Down Menus ..............................................................22
  Navigating Between and Within Content Modes ................................................22
    Navigating within Whiteboard Content Mode ...................................................22
    Navigating within Application Sharing Mode ....................................................23
    Navigating within Web Tour Mode ...................................................................24
  Navigating Between and Reading Whiteboard Pages ...........................................24
  Navigating Between Chat Conversation Tabs ....................................................25
  Using Mnemonic and Keyboard Shortcuts ..........................................................26
    Mnemonics ..........................................................................................................26
    Keyboard Shortcuts ............................................................................................27
      Hot Keys ............................................................................................................27
      Configuring Hot Keys ......................................................................................32
Chapter 4 The Activity Window ........................................................................37
  Opening and Closing the Activity Window ........................................................38
  Displaying Events ................................................................................................38
    Filtering Events for Display ..............................................................................39
      Audible Notifications Filter ...........................................................................39
      Module Event Filter .........................................................................................40
      Importance Event Filter ...............................................................................41
      Event Filtering Preferences Panel ...................................................................42
  Resizing Activity Window Text ...........................................................................44
  Showing/Hiding Time Stamps .............................................................................44
  Reading Events with a Screen Reader ...............................................................45
  Entering Commands ............................................................................................45
Hosting Options .................................................................66
Chat Options ........................................................................68
Changing the Chat Text Size ................................................68
Adding Emoticons to your Chat Message ..............................69
Changing the Notes Text Size ................................................70

Appendix A: Chat Emoticon Text Strings ..................................71
Copyright .............................................................................75
Trademarks ............................................................................75
Preface

This guide is written for Blackboard Collaborate Web Conferencing users with visual, auditory or motor disabilities. It describes the accessibility features in Blackboard Collaborate intended for these users.


See Getting Started on page 5 for a list of which sections in this guide are relevant to your particular needs.

Conventions Used in this Guide

Variables

There are a few places in Blackboard Collaborate Web Conferencing that are populated with data specific to the session. Because we do not know in advance what those data (e.g., words or names) will be, in this guide they are represented by variables enclosed in angle brackets. For example, the variable <Panel Name> is used in the discussion of Restoring Default Preference Settings to represent the name of the currently selected panel.
Notes
Six types of notes may be used in this guide to highlight information:

**Note:** Notes are used to highlight important information or to present asides relevant to the topic at hand.

**Tip:** Tips provide helpful information on how to most effectively use a particular feature of the product.

**Caution:** Cautions alert you to potentially confusing terminology or difficulties that may occur when using the product.

**Warning:** Warnings alert you to potentially serious problems.

Notes of this format are used to highlight Linux-specific information.

Notes of this format are used to highlight Mac-specific information.

Notes of this format are used to highlight information specific to mobile devices (mobile phones and tablets).

Typographical Conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Number</td>
<td>Indicates a step in a task.</td>
</tr>
<tr>
<td>○ Hollow bullets</td>
<td>Indicates that there are several options available for completing a task, but only one is necessary.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Represents clickable elements in the user interface (e.g., text links, buttons, tabs, etc.). Also used to give emphasis to words.</td>
</tr>
<tr>
<td><em>Italicics</em></td>
<td>Represents menu items, options and parameters. Also used for cross references and names of documents.</td>
</tr>
<tr>
<td>Monospace</td>
<td>Indicates pathnames, filenames, folders and command lines.</td>
</tr>
<tr>
<td>&lt;brackets&gt;</td>
<td>Indicates variables.</td>
</tr>
</tbody>
</table>
Getting Help

Documentation and Learning Resources
Documentation and learning resources (for all Blackboard Collaborate products) are available on the On-Demand Learning Center, which can be reached as follows:

- In your browser, enter the following address:
  http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center.aspx
- From within Blackboard Collaborate Web Conferencing, select Additional Documentation from the Help menu.

You can directly open the following documents from within Blackboard Collaborate Web Conferencing by selecting them from the Help menu:

- Keyboard Shortcuts
- Accessibility Guide for Participants
- Blackboard Collaborate Essentials for Participants

Technical Support
Blackboard Collaborate technical support and the support Knowledge Base are available through the Support Portal:
http://support.blackboardcollaborate.com

Community
We encourage Blackboard Collaborate users of all levels to join our Collaborati User's Group (https://www.coursesites.com/s/_Collaborati), a community in which users can share their experiences, ideas, research, and best practices with their peers via forums and user-generated blogs.

Blackboard Collaborate Product Feedback
Blackboard Collaborate welcomes your comments and suggestions. If you have an idea for a new feature or enhancement, or would like to send other feedback, please send an email to BBCollaborateFeedback@blackboard.com.
Your feedback will be sent directly to our Product Management Team.
Chapter 1

Getting Started

Before you begin using the accessibility features of Blackboard Collaborate Web Conferencing, we recommend you do the following:

- Ensure your system meets the necessary requirements (see System Requirements below).
- Get Blackboard Collaborate ready to use accessibility features (see Getting Ready for a Blackboard Collaborate Session on page 7).
- Read the parts of this guide that are most relevant to you (see Using this Guide on page 7).
- Familiarize yourself with the Blackboard Collaborate user interface (see The Blackboard Collaborate Web Conferencing Room on page 11).

System Requirements

In order to use the accessibility features in Blackboard Collaborate Web Conferencing, you must meet the following system requirements.

Blackboard Collaborate Web Conferencing

The full set of accessibility features are available only in the English version of Blackboard Collaborate version 12.
Operating System

Only Windows operating systems support all of the Blackboard Collaborate accessibility features:

- Windows XP (32 bit), Windows Vista (32 bit or 64 bit) or Windows 7 (32 bit or 64 bit)
- Pentium III 1 GHz processor
- 256 MB RAM

Linux (Ubuntu 11.10 or higher) and Mac (Mac OS X 10.6 or higher) users can use only some of the Blackboard Collaborate accessibility features (e.g., keyboard navigation). There is no screen reader capability on these systems.

Note: Accessibility features are not officially supported on Linux and Mac systems.

Java Web Start

Java version 1.5 or higher (32-bit or 64-bit) is required to run Blackboard Collaborate and the Java Access Bridge (see below).

To check to see if you have the correct version of Java, open the following web page:

http://support.blackboardcollaborate.com/ics/support/default.asp?deptID=8336&task=knowledge&questionID=1473

The “Step 1- Checking System Requirements” will tell you whether or not you have the required version of Java Web Start and, if not, provide a link to the Java download page.

Screen Readers

JAWS (version 12 or 13) is the only supported screen reader for Blackboard Collaborate.

Note: JAWS 12 and 13 support both 32-bit and 64-bit OSs/JVMs.

Java Access Bridge

The Java™ Access Bridge is a technology that allows assistive technologies (such as screen readers, magnifiers, etc.) to access Java applications and applets. In order to use Blackboard Collaborate web conferencing version 12 with the JAWS screen reader, you must install Java Access Bridge version 2.0.2.

Download the Java Access Bridge version 2.0.2 from following Oracle web page:

For instructions on installing the access bridge, refer to the following Freedom Scientific FAQ:

Note: Whenever you install a new version of Java, you must re-install the Java Access Bridge.

Getting Ready for a Blackboard Collaborate Session

If you will be using JAWS to navigate through the Blackboard Collaborate Web Conferencing interface, be sure to do the following:

1. Start JAWS before you log in to the session.
2. Verify that the Java Access Bridge is working.
3. Configure JAWS to read all access keys so the mnemonic keys are spoken aloud; otherwise, you won’t be able to identify them. This setting is found under the basic settings of JAWS.

It is advisable to enter the room early (before the session starts) so you can configure your Blackboard Collaborate interface to suit your particular needs. How early you can enter the room is set by the session creator. The default is 30 minutes but the session creator may change that.

1. For those using audio in your Blackboard Collaborate session, run the Audio Setup Wizard to ensure your microphone and speakers are set to suitable levels. For details, see Using the Audio Setup Wizard on page 57.
2. For all users, set which Audible and Visual Notifications you wish to receive in the session. For details, see Setting Notification Preferences on page 61.

Using this Guide

Blackboard Collaborate Web Conferencing has been designed to meet the needs of users of various abilities. Some of the accessibility features are helpful to those whose mobility make it difficult for them to use a mouse, others are for users who are deaf or hard of hearing and others are for users with limited vision (including color blindness) or no vision.

The following table lists the various target audiences and the accessibility features from which each would benefit, including a reference to the relevant section in this document.
<table>
<thead>
<tr>
<th>User Issue</th>
<th>Accessibility Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Vision</td>
<td>Maximizing window and panel sizes: refer to <em>Managing Panels and Windows</em> on page 14&lt;br&gt;Activity Window: refer to <em>The Activity Window</em> on page 37&lt;br&gt;Audible Notifications: refer to <em>Audible Notifications</em> on page 61&lt;br&gt;Keyboard Shortcuts: refer to <em>Keyboard Shortcuts</em> on page 27&lt;br&gt;Hot Keys: refer to <em>Hot Keys</em> on page 32&lt;br&gt;Keyboard Navigation: refer to <em>Keyboard Navigation</em> on page 20&lt;br&gt;Chat text size options: refer to <em>Changing the Chat Text Size</em> on page 68&lt;br&gt;Notes text size options: refer to <em>Changing the Notes Text Size</em> on page 70&lt;br&gt;Session Plan Display Setting preferences: refer to <em>Display Settings</em> on page 1&lt;br&gt;Application Sharing hosting option <em>Emphasize cursor</em>: refer to <em>Hosting Options</em> on page 66&lt;br&gt;Application Sharing viewing features to scale the shared content and maximize the content area: refer to <em>Application Sharing Options</em> on page 65</td>
</tr>
<tr>
<td>Deaf or Hard of Hearing</td>
<td>Activity Window: refer to <em>The Activity Window</em> on page 37&lt;br&gt;Visual Notifications: refer to <em>Setting Notification Preferences</em> on page 61&lt;br&gt;Closed-Captioning: refer to <em>Closed-Captioning</em> on page 49&lt;br&gt;Audio volume controls: refer to <em>Adjusting Microphone and Speaker Levels</em> on page 60&lt;br&gt;Audio Setup Wizard: refer to <em>Using the Audio Setup Wizard</em> on page 57</td>
</tr>
<tr>
<td>User Issue</td>
<td>Accessibility Features</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Mobility           | Keyboard Shortcuts: refer to *Keyboard Shortcuts* on page 27  
                      | Hot Keys: refer to *Hot Keys* on page 32  
                      | Mnemonic Keys: refer to *Mnemonics* on page 26  
                      | Keyboard Navigation: refer to *Keyboard Navigation* on page 20 |
| Color Blind        | Session Plan Viewing options *Color of covered items* and *Color of action hyperlinks*: refer to *Viewing Options* on page 1  
                      | Closed-Captioning window display options: refer to *Window Display Options* on page 53  
                      | Application Sharing hosting options *Shared Region Highlight Color* and *Emphasize cursor*: refer to *Hosting Options* on page 66 |
Chapter 2

The Blackboard Collaborate Web Conferencing Room

The Blackboard Collaborate Web Conferencing room consists of six main components: the menu bar at the top, three panels on the left (Audio & Video panel on top, the Participants panel in the middle and Chat panel on the bottom), the Collaboration toolbar at the top of the right side and the main content area on the right (for displaying Whiteboard, Application Sharing and Web Tour content).

Note: For mobile device users, the Web Conferencing room will not be exactly as described in this chapter. For a discussion of attending sessions on mobile devices, see the Mobile User’s Guide:
http://www.blackboard.com/docs/documentation.htm?DocID=611027PDF

- The **Menu bar** contains the File, Edit, View, Tools, Windows and Help menus.
- The **Audio & Video panel** enables you to participate in conversations either using a microphone and speakers (or headset) or via a teleconference. You also can transmit and receive Video during the session and preview your video before transmitting it.
- The **Participants panel** provides a list of all Participants and Moderators in the session and information about their current activities, such as talking (Audio), transmitting Video, sending a Chat message, using the Whiteboard drawing tools and conducting an Application Sharing session.

  Above the Participants list is a small toolbar containing buttons for raising your hand and stepping away from the session and menus for selecting polling responses and feedback options.

- The **Chat panel** enables you to send Chat messages to everyone in the room or to Moderators only. By selecting names in the Participants list, you can send private Chat messages to individuals. Messages can be printed and saved to track session communication.

- The **Collaboration toolbar** contains three buttons for switching between the three content modes (Whiteboard, Application Sharing and Web Tour), an Information menu for obtaining session information (e.g., connection type) and starting the Timer, a Load Content button for loading content into the session and the Record button.

- The **Content area** is the main presentation window. Moderators use this region to load presentations. Everyone can use the tools on the Whiteboard to draw or write. All the objects and images on the Whiteboard are dynamic and can be modified. Everyone can print the Whiteboard pages or save them to a file to review later (unless the Whiteboard has been protected).
The Content Area Modes

The content area on the right side of your Blackboard Collaborate Web Conferencing interface, enables you to exchange information and ideas with others through three different features:

- the Whiteboard, for sharing presentations and drawings;
- Application Sharing, for sharing individual applications or your entire desktop; and
- Web Tour, for sharing web pages.

These features share space in the content area, with each representing a "mode" in the content area. Although Whiteboard content, Application Sharing content and Web Tour content may all be loaded at the same time, you will be able to see the content of only one mode at a time.

Only certain users can switch between modes:

- Moderators can switch between all modes.
- Participants with Application Sharing permission can switch to Application Sharing mode and back to Whiteboard mode.
- Participants with Web Tour permission can switch to Web Tour mode and back to Whiteboard mode.

**Note:** Participants with Whiteboard permission but not Application Sharing or Web Tour permission cannot switch to Whiteboard mode from either of the other two modes. This safeguards against Participants switching modes during someone else's Web Tour or Application Sharing presentation.

When someone switches modes, everyone in the session will follow them to the new mode.

**Caution:** Be careful not to inadvertently switch modes on someone else who is presenting content. Everyone in the session will follow you to the new mode.
To switch modes, do one of the following:

- Click on the button in the Collaboration toolbar associated with the desired mode.
- Select the desired mode from the View menu.
- Use the keyboard shortcut associated with the desired mode:
  - Whiteboard mode: Ctrl+Alt+W (Command-Option-W on Mac)
  - Application Sharing mode: Ctrl+Alt+A (Command-Option-S on Mac)
  - Web Tour mode: Ctrl+Alt+U (Command-Option-U on Mac)

You can easily see which mode is selected by noting which button in the Collaboration toolbar is colored. In the Collaboration toolbar below, the current mode is Whiteboard mode.

1. Whiteboard mode button
2. Application Sharing mode button
3. Web Tour mode button

Managing Panels and Windows

The Blackboard Collaborate Web Conferencing interface consists of panels and windows. Panels can be collapsed, expanded, detached and reattached, resized and, in their detached state, can be moved. These side panels (Audio & Video, Participants and Chat) also can be hidden. For details, see Working with Panels on page 16.

The main application window can be minimized, maximized, moved, resized and closed. Other windows can be opened, moved, resized and closed. For details, see Working with Windows below.

Working with Windows

There are a number of different kinds of windows in Blackboard Collaborate Web Conferencing: the main application window, module windows (such as the Notes window and the Multimedia Library), dialog boxes (such as the Preferences dialog and Create Breakout Rooms dialog) and utility windows (such as the Object Explorer and Page Explorer).

Below are the ways you can manage your windows:

- **Open the main application window**: To open the window you need to join the session by clicking on a link.
- **Open a main module window:** To open the window of one of the main modules, select it from the Window menu or, if available, open it using its associated keyboard shortcut (see *Keyboard Shortcuts* on page 27.)

<table>
<thead>
<tr>
<th>Window Menu Section</th>
<th>Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Activity</td>
<td>Ctrl+Shift</td>
</tr>
<tr>
<td>Show Session Plan</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Show Graphing Calculator</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Show Closed-Captioning</td>
<td>Ctrl+F8</td>
</tr>
<tr>
<td>Show Quiz Manager</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Show Notes</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Show Multimedia Library</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Show File Transfer Library</td>
<td></td>
</tr>
</tbody>
</table>

- **Move a window:** Grab the window by its title bar and, while holding down your mouse, drag it to the desired location and then drop it by releasing the mouse.

- **To resize a window:** Grab a window border and drag it. Hold your mouse over any side or a corner and, when the cursor changes to a two-headed arrow, click and drag the border of the window to contract or expand it.

- **Minimize or maximize the main application window:** Use the standard conventions of your operating system for minimizing and maximizing windows. For example, on Windows, use the Minimize and Maximize buttons in the window's title bar:

- **Un-obscure a window:** If part of a window is obscured by another window or panel, click on the window itself to bring it to the front of the other window or panel.

**Tip:** If you can’t find a window because it is hidden beneath other windows, an easy way to find it is to select *Restore Default Layout* from the View menu and then open your window again.
Close a main module window: To close a main module window, do one of the following:

- Click on the window’s Close button in the title bar of the window.
- Enter Ctrl+W (Command-W on Mac)
- Enter Alt+F4 (Windows and Linux only)

Close the main application window: If you close the main application window you will leave the session. For details, see the Moderator’s Guide.

Working with Panels

The default when you first join a Blackboard Collaborate Web Conferencing session is for the Participants and Chat panels to be expanded and attached and the Audio & Video panel to be collapsed and attached. Blackboard Collaborate will remember the state in which you left your panels (expanded or collapsed and attached or detached) from one session to the next (but only if you are logged in to the same computer).

Below are the ways you can manage your panels:

- Collapse and expand a panel: By default, the panels are expanded. If you want to make more room for one of the panels, you can collapse the others.

  To collapse a panel, click on the Collapse button in the panel's title bar:

  ![Collapse button]

  To expand the panel back to its former state, click on the Expand button in the panel's title bar:

  ![Expand button]

- Move a panel: Grab the panel (either attached or detached) by its title bar and, while holding down your mouse, drag it to the desired location and then drop it by releasing the mouse.
- **Detach and reattach a panel:** Panels can be detached so you can move them to a more convenient location.

  To detach a panel, do one of the following:
  - From the Options menu, select Detach Panel.
  - Drag and drop the panel out of the main application window. (See **Move a panel** above.)

  To reattach a panel, do one of the following:
  - From the Options menu, select Attach Panel.
  - Drag and drop the panel back into the main application window. (See **Move a panel** above.)
  - From the View menu, select Restore Default Layout.
  - Click on the panel's Close button:

- **Reorder an attached panel:** Drag and drop the panel up or down within the side bar area (left side) of the main application window. (See **Move a panel** above.)

- **Hide attached side panels:** You can make the Content area larger by hiding the side bar area (left side) of the main application window. To do so, in the View menu, unselect (uncheck) Show Side Bar. To restore the side bar, reselect it. Alternatively, you can grab the border of any one of the panels and drag it all the way to the left. To bring the side bar back, grab it again and move to the right.

- **Resize a panel:** Grab a panel border and drag it. Hold your mouse over any side (either attached or detached) or a corner (detached only) and, when the cursor changes to a two-headed arrow, click and drag the border of the panel to contract or expand it.

- **Un-obscure detached panels:** If part of the panel is obscured by another panel or window, click anywhere on the panel to bring it to the front of the other panel or window.
Chapter 3

Navigation

Before using Blackboard Collaborate Web Conferencing, it may be useful to familiarize yourself with the user interface. See *The Blackboard Collaborate Web Conferencing Room* on page 11 for a description of the main user interface components.

There are three ways to navigate through the Blackboard Collaborate user interface without having to use a mouse:

- Keyboard navigation – see *Keyboard Navigation* on next page
- Mnemonics – see *Mnemonics* on page 26
- Shortcut keys – see *Keyboard Shortcuts* on page 27

For information about navigating within some specific areas, refer to the following:

- *Navigating Between and Within Content Modes* on page 22
- *Navigating Between and Reading Whiteboard Pages* on page 24
- *Navigating Between Chat Conversation Tabs* on page 25
Keyboard Navigation

There are four levels of keyboard navigation in Blackboard Collaborate Web Conferencing:

- between modules in the main application window
- between elements (both within and across modules)
- within toolbars of a secondary window
- within menus

Using the navigation methods described in the following sections, navigate to the desired function to bring it into focus. When you wish to activate that function (execute the command), press **Space**.

Navigating Between Modules

When you join an Blackboard Collaborate session, the Participants panel is in focus. Press **F6** (the same on the Mac) to cycle keyboard focus between the main Blackboard Collaborate modules, in the order listed below:

- **Participants panel**: focus goes to the top name in the Participants list.
- **Chat panel**: focus goes to the Message text box.
- **Collaboration toolbar**: focus goes to the Whiteboard mode button.
- **Action bar**: focus goes to the New Page button.
- **Audio & Video panel**: focus goes to the Talk button.

>Note: If you change the order of the panels, the F6 navigation order will be different. For information on reordering the panels, see *Working with Panels* on page 16.

Navigating Between Elements

You can navigate through the Blackboard Collaborate user interface one element (e.g., button, field, option, etc.) at a time by tabbing. The **Tab** key moves you forward through the Blackboard Collaborate elements in the sequence described below. To move backwards in the sequence, enter **Shift+Tab**.

>Note: Within each panel or window, tabbing moves through its elements from left to right and top to bottom.
Your tabbing sequence may differ from that described below since the elements you see in the user interface depends on your permissions, including whether or not you are a Moderator or Participant.

- **Participants List** – When you join a Blackboard Collaborate session, focus will be on the top name in the Participants list. Within the list you can move through the names using the up and down arrow keys. Press **Space** to open the Participant Options menu for the person currently in focus.

- **Chat Panel** – Next you will tab through the elements in the Chat panel: Expand/Collapse button, Options menu, Conversation pane, Message text box and Conversation tabs. (For instructions on moving between Conversation tabs, see **Navigating Between Chat Conversation Tabs** on page 25.)

- **Collaboration Toolbar** – Next you will tab through the elements in the Collaboration toolbar: Whiteboard Mode button, Application Sharing Mode button, Web Tour Mode button, Timer elements (if the Timer is running), Information menu, Load Content button and Record button. (For instructions on changing modes, see **Navigating Between and Within Content Modes** on next page.)

- **Action Bar** – Next you will tab through the elements in the Action bar for the currently selected mode or, the Available Share Selection dialog for Application Sharing Mode.

- **Audio & Video Panel** – Next you will tab through the elements in the Audio and Video panel: Expand/Collapse button, Audio Setup Wizard button, Options menu, Microphone Level slider, Speaker Level slider, Talk button, Transmit Video button and Preview Video button.

- **Participants Panel** – Next you will tab through the elements in the Participants panel: Expand/Collapse button, Global Options menu, Feedback menu, Step Away button, Raise Hand button, Polling Response menu and then, finally, back to the Participants list.

**Navigating Within a Toolbar of a Module Window**

When you open a module's window, you can use tabbing to navigate through the various elements of its interface, with one exception: toolbar buttons. The Closed Captioning, File Transfer Library and Notes windows have graphic tool bars with buttons represented by icons. You must explicitly enable tabbing to access these buttons.

To do so, enter **Alt+F8 (Option-F8 on the Mac)**. To turn toolbar tabbing off, enter Alt+F8 (Option-F8 on the Mac) again.
Navigating Within Drop-Down Menus

To open an Options menu, Participant interaction menu (Feedback and Polling Response menus) or other drop-down menu, tab to it and press **Space**. Using up and down arrow keys, move to the desired menu option and press **Space** to activate it. If the menu option is a sub-menu, press **Space** or the right arrow key to open it.

To close the menu without selecting a menu option, press **Escape**.

**Tip:** To access the main menus (e.g., File, Edit, etc.) use mnemonic keys. (See **Mnemonics** on page 26.) You cannot use tabbing to open these menus; however, once a menu is open, you can use your arrow keys to navigate within it and **Space** to execute the menu item command.

Navigating Between and Within Content Modes

When you open a new session, the Whiteboard is your default content mode. You can use keyboard navigation or keyboard shortcuts to move between content modes and keyboard navigation to move within content modes.

**Note:** To switch to a content mode, you must be a Moderator or a Participant with permission to use that mode.

Navigation within each content mode is unique, as described below.

Navigating within Whiteboard Content Mode

Follow the steps below to switch to Whiteboard mode and access the functions in the Action bar:

**Note:** If you are a Participant or a Moderator without the Whiteboard permission, **F6** navigation will place focus on the *Scaling menu* of the Whiteboard Action bar.

1. To switch to Whiteboard mode, do one of the following:
   - **Keyboard Shortcut**
     Enter Control+Alt+W (Command-Option-W on Mac)
   - **Keyboard Navigation**
     Press **F6** (the same on the Mac) to cycle keyboard focus to the Collaboration toolbar. By default, you will be in Whiteboard Mode.

2. Press **F6** again to move to the Whiteboard Action bar.
3. Use Tab, Shift+Tab and the arrow keys to move between the elements in the Action bar and the adjacent Navigation bar.

4. Press Space to activate the selected function.

**Navigating within Application Sharing Mode**

Follow the steps below to switch to Application Sharing mode and start hosting an Application Sharing session:

---

**Note:** If someone else is already hosting an Application Sharing session (you are already in Application Sharing mode), F6 navigation will place focus on the Scale to Fit option of the Application Sharing Action bar.

---

1. To switch to Application Sharing mode, do one of the following:
   - **Keyboard Shortcut**
     Enter Control+Alt+A (Command-Option-A on Mac)
   - **Keyboard Navigation**
     i. Press F6 (the same on the Mac) to cycle keyboard focus to the Collaboration toolbar. By default, you will be in Whiteboard Mode.
     ii. Press Tab or Right Arrow once to move to the Application Sharing Mode button.
     iii. Press Space to activate Application Sharing Mode. The Application Sharing Selections dialog will open.

2. Press Tab five times to move through the elements in the Collaboration toolbar to the Share Desktop (the first) field of the Application Sharing Selections dialog.

3. You have two options:
   - **Share your entire desktop:** Press any of the arrow keys to select Share Desktop, press Tab three times to move to the Share button and press Space to start sharing your desktop.
   - **Share a specific application only:** Press Tab to move to the list of available applications and then, using the arrow keys, select the desired application from the list. Press Tab twice to move to the Share button and press Space to start sharing the selected application.
Navigating within Web Tour Mode

Follow the steps below to switch to Web Tour mode and start hosting a Web Tour:

**Note:** If someone else is already hosting a Web Tour session (you are already in Web Tour mode) and you don't have Web Tour permission, **F6** navigation will place focus on the *Back* button of the Web Tour Action bar.

1. To switch to Web Tour mode, do one of the following:
   - **Keyboard Shortcut**
     Enter Control+Alt+U (Command-Option-U on Mac)
   - **Keyboard Navigation**
     i. Press **F6** (the same on the Mac) to cycle keyboard focus to the Collaboration toolbar. By default, you will be in Whiteboard Mode.
     ii. Press **Tab** or **Right Arrow** twice to move to the Web Tour Mode button.
     iii. Press **Space** to activate Web Tour Mode. The Web Tour Action bar will open and focus will be in the Address text box.

2. Use **Tab**, **Shift+Tab** and the arrow keys to move between the elements in the Action bar.

3. Press **Space** to activate the selected function or, if in the Address text box, open the specified web page.

Navigating Between and Reading Whiteboard Pages

If you are using a JAWS screen reader, you can read the text of presentations imported into the Whiteboard via the Activity Window. Navigate to the desired page (as instructed below) and open the Activity Window using Control + / (Command- / on Mac) to read the textual content of that page. You will need to move focus to the bottom of the window. (For details on using the Activity Window, see *The Activity Window* on page 37.)

**Note:** You can freely navigate between pages in breakout rooms but must be given permission by the Moderator to navigate between pages of the Main room. You will know you are free to move between Main room pages when you see a red border around your Whiteboard content area.

To move directly to a specific Whiteboard page, select it from the Go to Page menu in the Whiteboard navigation bar. For instructions on keyboard navigation to that menu, see *Navigating within Whiteboard Content Mode* on page 22.
To move to the next page, use any of the following methods:

- **Keyboard Shortcut**
Enter Alt+Page Down (Option-Page Down on Mac).

- **Mnemonic Keys**
Using mnemonics keys, from the Tools menu select Whiteboard followed by Go to Next Page. (For instructions on using mnemonic keys, see Mnemonics on next page.)

To move to the previous page, use any of the following methods:

- **Keyboard Shortcut**
Enter Alt+Page Up (Option-Page Up on Mac).

- **Mnemonic Keys**
Using mnemonics keys, from the Tools menu select Whiteboard followed by Go to Previous Page. (For instructions on using mnemonic keys, see Mnemonics on next page.)

- **Keyboard Navigation**
Navigate to and activate the Next Page button in the Whiteboard Navigation bar.
If focus is on the Go to Page menu of the Navigation bar, press the Down Arrow.  
(For instructions on keyboard navigation in Whiteboard Mode, Navigating within Whiteboard Content Mode on page 22.)

Navigating Between Chat Conversation Tabs

You can use keyboard navigation to move between the private Chat conversation tabs in the Chat panel.

- **Tip:** If you want to know when a new private Chat message has been received, enable the Audible Notification "Private Chat Message Received".  
  For details, see Audible Notifications on page 61.
1. Press **F6** (the same on the Mac) to cycle keyboard focus to the Chat panel.

2. Press **Tab** twice to move to the currently open conversation tab. (By default, this is the Room conversation.)

3. Use the arrow keys to move to the desired conversation tab.

4. Press **Space** to open the conversation.

If there are too many conversation tabs to fit in the Chat panel, they will be added to a drop-down menu to the right of the displayed conversation tabs. To open a conversation tab in the menu, do the following:

1. From your currently open conversation tab, press **Tab**. This will move focus to the conversation drop-down menu.

   **Note:** if there is no conversation drop-down menu, focus will move to the Collaboration toolbar.

2. Press **Space** to open the menu.

3. Use the arrow keys to move to the desired conversation.

4. Press **Space** to open the conversation.

### Using Mnemonic and Keyboard Shortcuts

Instead of using your mouse to select a menu option, you can use your keyboard. Using mnemonic or Keyboard Shortcuts saves time because you do not have to complete multiple steps (e.g., clicking on a menu and then clicking on an option), nor do you have to take your hand off the keyboard to issue the command.

**Note:** Mnemonic and standard Keyboard Shortcuts are enabled only when you have input focus on the Blackboard Collaborate Web Conferencing window. Focus is not required for Hot Keys.

### Mnemonics

A mnemonic is an underlined letter or number that appears in a menu title or menu option that, when pressed in conjunction with the ALT key, activates a command or navigates to an element in the user interface.

**Mac Note:** Keyboard mnemonics are not supported on the Mac.
Note: On Windows, depending upon your configuration, you may have to toggle ALT the key before the options in the menus will display the underlined character or number.

To choose a menu option with mnemonics, do the following:

1. Press the ALT key, note which letter or number (mnemonic) is underlined in the desired menu name and enter it on your keyboard. The menu options for that main menu will appear. For example, if you press ALT+F, the File menu will appear.

2. Again, note the mnemonic for the desired option in the menu and enter it, with or without the ALT key.

   To select a menu option from a sub-menu, repeat step 2.

**Keyboard Shortcuts**

You can quickly accomplish tasks you perform frequently by using keyboard shortcuts (both standard keyboard shortcuts and hot keys), which are one or more keys you press in combination within Blackboard Collaborate Web Conferencing to perform a function. For example, instead of clicking the Raise Hand button in the Participants panel or selecting Raise Hand from the Interaction menu, you can press Ctrl+R (Command-R on Mac OS X) to raise your hand.

Hot keys differ from standard keyboard shortcuts in some important ways. For details, and a discussion of hot keys, see *Hot Keys* on page 32.

Note: The keyboard shortcuts were defined with an extended (full) keyboard layout in mind. If your keyboard does not have a key used in a keyboard shortcut, you will need to use the menu item or toolbar button to perform the desired function.

Caution: If you are sharing an application that has a keyboard shortcut identical to one in Blackboard Collaborate, and focus is on Application Sharing, the shortcut will activate its associated command in the shared application, not in Blackboard Collaborate.

The following table lists the keyboard shortcuts (both standard and hot keys) present in Blackboard Collaborate to quickly perform a number of common functions. The first column describes the function to be performed, the second column lists the Windows and Linux keyboard shortcuts and the third column gives the Mac keyboard shortcuts. Keys are grouped into sections based on the Blackboard Collaborate module being used.

Note: To access the list of keyboard shortcuts while in a session, select Keyboard Shortcuts from the Help menu.
### Application, Window and File Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Windows, etc. keys</th>
<th>Mac keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quit Blackboard Collaborate</td>
<td>Alt+F4</td>
<td>Command-Q</td>
</tr>
<tr>
<td></td>
<td>Ctrl+Q</td>
<td></td>
</tr>
<tr>
<td>Hide Blackboard Collaborate</td>
<td>N/A</td>
<td>Command-H</td>
</tr>
<tr>
<td>Hide other applications</td>
<td>N/A</td>
<td>Option-Command-H</td>
</tr>
<tr>
<td>Close window (Notes, Activity, Closed-Captioning, Calculator)</td>
<td>Alt+F4</td>
<td>Command-W</td>
</tr>
<tr>
<td></td>
<td>Ctrl+W</td>
<td></td>
</tr>
<tr>
<td>Switch to Whiteboard Mode</td>
<td>Ctrl+Alt+W</td>
<td>Command-Option-W</td>
</tr>
<tr>
<td>Switch to Application Sharing Mode</td>
<td>Ctrl+Alt+A</td>
<td>Command-Option-A</td>
</tr>
<tr>
<td>Switch to Web Tour Mode</td>
<td>Ctrl+Alt+U</td>
<td>Command-Option-U</td>
</tr>
<tr>
<td>Open Preferences dialog box</td>
<td>Ctrl+Comma</td>
<td>Command-Comma</td>
</tr>
<tr>
<td>Save Participants list, Chat conversation or Whiteboard</td>
<td>Ctrl+S</td>
<td>Command-S</td>
</tr>
<tr>
<td>Print Participants list or Whiteboard</td>
<td>Ctrl+P</td>
<td>Command-P</td>
</tr>
</tbody>
</table>

### Keyboard Navigation Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Windows, etc. keys</th>
<th>Mac keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the <strong>next</strong> main module in the user interface. The default order is Participants panel, Chat panel, Collaboration toolbar, Action bar and Audio &amp; Video panel. (If you change the order of the panels, the order will change.)</td>
<td>F6</td>
<td>F6</td>
</tr>
<tr>
<td>Open the Action bars of Whiteboard Mode and Web Tour mode</td>
<td>F6</td>
<td>F6</td>
</tr>
<tr>
<td>Move to the <strong>previous</strong> main module in the user interface. (See F6 above for the order of modules.)</td>
<td>Shift+F6</td>
<td>Shift-F6</td>
</tr>
<tr>
<td>Function</td>
<td>Windows, etc. keys</td>
<td>Mac keys</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>---------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Move to the <strong>next</strong> user interface element (e.g., button, field, option) in a main module or UI element. For example, if focus is in the Collaboration toolbar, Tab and Shift-Tab can be used to move between the three modes (Whiteboard, Application Sharing and Web Tour), the Information menu, the Load Content button and the Record button.</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Move to the <strong>previous</strong> user interface element (e.g., button, field, option) in a main module (see example for Tab above)</td>
<td>Shift+Tab</td>
<td>Shift-Tab</td>
</tr>
<tr>
<td>Activate the currently selected function</td>
<td>Space</td>
<td>Space</td>
</tr>
<tr>
<td>Enable tabbing in toolbars of secondary windows (Closed Captioning, Notes, Activity Window, File Transfer)</td>
<td>Alt+F8</td>
<td>Option-F8</td>
</tr>
</tbody>
</table>
| Move keyboard focus between open windows (Notes, File Transfer, Activity, Closed-Captioning, Calculator) | Alt+F6 (Windows XP and Linux only) | Command-`
| Open Options menu of the panel or toolbar in focus (Audio & Video, Chat, Participants, Whiteboard action bar, Whiteboard navigation bar or Web Tour) | Ctrl+Shift+O        | Command-Shift-O |

**Activity Window Functions**

<table>
<thead>
<tr>
<th>Open Activity Window</th>
<th>Ctrl+/</th>
<th>Command-/</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Activity Window</td>
<td>Ctrl+/</td>
<td>Command-W</td>
</tr>
<tr>
<td></td>
<td>Alt+F4</td>
<td>Ctrl+W</td>
</tr>
</tbody>
</table>

**Audio Functions**

<table>
<thead>
<tr>
<th>Press the Talk button</th>
<th>Ctrl+F2</th>
<th>Control-F2</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Note: this is a Hot Key — see <em>Hot Keys</em> on page 32.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Release the Talk button</td>
<td>Ctrl+F2</td>
<td>Control-F2</td>
</tr>
<tr>
<td>(Note: this is a Hot Key — see <em>Hot Keys</em> on page 32.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>Windows, etc. keys</td>
<td>Mac keys</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Adjust microphone level down</td>
<td>Ctrl+Shift+Down Arrow</td>
<td>Command-Shift-Down Arrow</td>
</tr>
<tr>
<td>Adjust microphone level up</td>
<td>Ctrl+Shift+Up Arrow</td>
<td>Command-Shift-Up Arrow</td>
</tr>
<tr>
<td>Adjust speaker level down</td>
<td>Ctrl+Alt+Down Arrow</td>
<td>Command-Option-Down Arrow</td>
</tr>
<tr>
<td>Adjust speaker level up</td>
<td>Ctrl+Alt+Up Arrow</td>
<td>Command-Option-Up Arrow</td>
</tr>
<tr>
<td><strong>Video Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Video transmission (Note: this is a Hot Key — see Hot Keys on page 32.)</td>
<td>Ctrl+F3</td>
<td>Control-F3</td>
</tr>
<tr>
<td>Stop Video transmission (Note: this is a Hot Key — see Hot Keys on page 32.)</td>
<td>Ctrl+F3</td>
<td>Control-F3</td>
</tr>
<tr>
<td><strong>Whiteboard Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select all objects in Whiteboard</td>
<td>Ctrl+A</td>
<td>Command-A</td>
</tr>
<tr>
<td>Open Page Explorer window</td>
<td>Ctrl+Shift+P</td>
<td>Command-Shift-P</td>
</tr>
<tr>
<td>Open Object Explorer window</td>
<td>Ctrl+Shift+T</td>
<td>Command-Shift-T</td>
</tr>
<tr>
<td>Copy selected object(s) or text in Whiteboard</td>
<td>Ctrl+C</td>
<td>Command-C</td>
</tr>
<tr>
<td>Cut selected object(s) or text in Whiteboard</td>
<td>Ctrl+X</td>
<td>Command-X</td>
</tr>
<tr>
<td>Paste copied or cut object(s) or text to Whiteboard</td>
<td>Ctrl+V</td>
<td>Command-V</td>
</tr>
<tr>
<td>Group selected objects</td>
<td>Ctrl+G</td>
<td>Command-G</td>
</tr>
<tr>
<td>Ungroup selected objects</td>
<td>Ctrl+U</td>
<td>Command-U</td>
</tr>
<tr>
<td>Delete selected object(s) or text in Whiteboard</td>
<td>Delete Backspace</td>
<td>Delete Backspace</td>
</tr>
<tr>
<td>Go to next page</td>
<td>Alt+Page Down</td>
<td>Option-Page Down</td>
</tr>
<tr>
<td>Go to previous page</td>
<td>Alt+Page Up</td>
<td>Option-Page Up</td>
</tr>
<tr>
<td>Move to first page at this topic level</td>
<td>Alt+Home</td>
<td>Option-Home</td>
</tr>
<tr>
<td>Function</td>
<td>Windows, etc. keys</td>
<td>Mac keys</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Move to last page at this topic level</td>
<td>Alt+End</td>
<td>Option-End</td>
</tr>
</tbody>
</table>

**Application Sharing Functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>Windows, etc. keys</th>
<th>Mac keys</th>
</tr>
</thead>
</table>
| Take back control of Application Sharing  
(Nota: this is a Hot Key — see *Hot Keys* on next page.) | Ctrl+Space | Control-Space |
| Stop Application Sharing  
(Nota: this is a Hot Key — see *Hot Keys* on next page.) | Ctrl+Shift+S | Control-Shift-S |

**Chat Functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>Windows, etc. keys</th>
<th>Mac keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move cursor to the Message text box of the Chat panel</td>
<td>Ctrl+M</td>
<td>Command-M</td>
</tr>
<tr>
<td>Select all Chat text in conversation pane</td>
<td>Ctrl+A</td>
<td>Command-A</td>
</tr>
<tr>
<td>Copy selected Chat text in conversation pane</td>
<td>Ctrl+C</td>
<td>Command-C</td>
</tr>
<tr>
<td>Paste copied Chat text to Chat Message text box, Whiteboard or external application</td>
<td>Ctrl+V</td>
<td>Command-V</td>
</tr>
</tbody>
</table>

**Participant Panel Functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>Windows, etc. keys</th>
<th>Mac keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raise or lower your hand</td>
<td>Ctrl+R</td>
<td>Command-R</td>
</tr>
<tr>
<td>Show that you have stepped away or come back</td>
<td>Ctrl+Shift+A</td>
<td>Command-Shift-A</td>
</tr>
<tr>
<td>Show smiley face</td>
<td>Alt+1</td>
<td>Option-1</td>
</tr>
<tr>
<td>Show LOL</td>
<td>Alt+2</td>
<td>Option-2</td>
</tr>
<tr>
<td>Show applause</td>
<td>Alt+3</td>
<td>Option-3</td>
</tr>
<tr>
<td>Show confusion</td>
<td>Alt+4</td>
<td>Option-4</td>
</tr>
<tr>
<td>Show approval</td>
<td>Alt+5</td>
<td>Option-5</td>
</tr>
<tr>
<td>Show disapproval</td>
<td>Alt+6</td>
<td>Option-6</td>
</tr>
<tr>
<td>Show Slower (when you want the presenter to slow down)</td>
<td>Alt+7</td>
<td>Option-7</td>
</tr>
<tr>
<td>Show Faster (when you want the presenter to speed up)</td>
<td>Alt+8</td>
<td>Option-8</td>
</tr>
<tr>
<td>Show None (when you want to clear all displayed emoticons)</td>
<td>Alt+0</td>
<td>Option-0</td>
</tr>
<tr>
<td>Function</td>
<td>Windows, etc. keys</td>
<td>Mac keys</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>--------------------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Notes Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Notes window</td>
<td>Ctrl+E</td>
<td>Command-E</td>
</tr>
<tr>
<td>Close Notes window</td>
<td>Alt+F4 Ctrl+W</td>
<td></td>
</tr>
<tr>
<td><strong>Closed-Captioning Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Closed-Captioning window</td>
<td>Ctrl+F8</td>
<td>Command-F8</td>
</tr>
<tr>
<td>Close Closed-Captioning window</td>
<td>Alt+F4 Ctrl+W</td>
<td></td>
</tr>
<tr>
<td><strong>Polling Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes - polling response</td>
<td>Ctrl+1</td>
<td>Command-1</td>
</tr>
<tr>
<td>No - polling response</td>
<td>Ctrl+2</td>
<td>Command-2</td>
</tr>
<tr>
<td>A - polling response</td>
<td>Ctrl+1</td>
<td>Command-1</td>
</tr>
<tr>
<td>B - polling response</td>
<td>Ctrl+2</td>
<td>Command-2</td>
</tr>
<tr>
<td>C - polling response</td>
<td>Ctrl+3</td>
<td>Command-3</td>
</tr>
<tr>
<td>D - polling response</td>
<td>Ctrl+4</td>
<td>Command-4</td>
</tr>
<tr>
<td>E - polling response</td>
<td>Ctrl+5</td>
<td>Command-5</td>
</tr>
<tr>
<td>None</td>
<td>Ctrl+0</td>
<td>Command-0</td>
</tr>
</tbody>
</table>

**Hot Keys**

Hot keys differ from standard keyboard shortcuts keys in two ways:

- You can modify the definition of these keys.
- You do not need to have input focus on the Blackboard Collaborate Web Conferencing window to use them (they are available system-wide).

By default, seven hot keys have been defined for the commonly used features in Blackboard Collaborate. You can use these default hot keys (listed in the following table) or define your own in the Preferences dialog. For instructions, see Configuring Hot Keys on the facing page.

**Linux Note:** Num Lock and Caps Lock must be turned off for Hot Keys to work in a Blackboard Collaborate Web Conferencing session running on Linux.
The default values for the two Talk hot keys are the same and the default values for the two Video hot keys are the same. If you keep the default values for the Talk keys, you can use Ctrl+F2 (Control-F2 on Mac) to toggle the Talk button on and off. If you keep the default values for the Video keys, you can use Ctrl+F3 (Control-F3 on Mac) to start and stop Video.

**Tip for Screen Reader Users:** With toggle commands, it is not always easy to remember which state you are currently in. You can always be sure that you are sending the desired command by redefining one of the hot keys in each toggle pair. For example, if you keep the default for pressing the Talk button Ctrl+F2 (Control-F2 on the Mac) and redefine the hot key for releasing the Talk button to something else, Ctrl+F2 (Control-F2 on the Mac) will always turn on the Talk button and your redefined hot key will always turn off the Talk button -- you will never have to know whether or the Talk button it is currently turned on or off.

The default hot keys are listed in the following table where the first column describes the function to be performed, the second column lists the Windows and Linux hot key and the third column gives the Mac hot key.

<table>
<thead>
<tr>
<th>Function</th>
<th>Windows &amp; Linux Key</th>
<th>Mac Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press the Talk button</td>
<td>Ctrl+F2</td>
<td>Control-F2</td>
</tr>
<tr>
<td>Release the Talk button</td>
<td>Ctrl+F2</td>
<td>Control-F2</td>
</tr>
<tr>
<td>Take back control of Application Sharing</td>
<td>Ctrl+Space</td>
<td>Control-Space</td>
</tr>
<tr>
<td>Stop Application Sharing</td>
<td>Ctrl+Shift+S</td>
<td>Control-Shift+S</td>
</tr>
<tr>
<td>Start Video transmission</td>
<td>Ctrl+F3</td>
<td>Control-F3</td>
</tr>
<tr>
<td>Stop Video transmission</td>
<td>Ctrl+F3</td>
<td>Control-F3</td>
</tr>
</tbody>
</table>

**Configuring Hot Keys**

Exercise caution when changing the default definitions of hot keys. Ensure you do not change a hot key definition to that of a hot key used by another application. You also should avoid key combinations that conflict with standard keyboard shortcut operations.

**Note:** On Windows and Linux, the hot key is restricted to one character. You may include one or more modifier keys (Shift, Control or ALT on Windows).

**Mac Note:** Mac OS X users must include at least one modifier key in the keystroke: ⇧Shift, ⌘Control, ⌥Option or ⌘Command).
Configure your hot keys in the Preferences dialog.

1. Open the Preferences dialog in one of the following ways:
   - From the Edit menu, select Preferences... (Windows & Linux)
     From the Blackboard Collaborate Web Conferencing menu, select Preferences (Mac OS X)
   - Enter Ctrl+Comma (Windows & Linux)
     Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select Hot Keys under General. The Hot Keys preferences panel appears.

   ![Hot Keys Preferences Panel](image)

   **Note:** If you see an X under the Valid column, this indicates that the hot key is not available. It is likely being used by another open application. Either redefine the hot key to something valid or close the other application.
3. From the Hot key preferences panel, select the hot key you wish to revise and click **Modify...**. The Edit Hot Key dialog opens.

4. Assign the keystrokes. Click on the down arrow to select a key from the key option list and then select the desired modifier keys by clicking on their check boxes. For example, the keystroke in the screen capture above is Ctrl+F2.

5. Click on **OK** to save the hot key configuration and close the Edit Hot Key dialog, or **Cancel** to close the Edit Hot Key dialog without saving your changes.

6. Click on **OK** to save your preferences and close the Preferences dialog, **Apply** to save your preferences and leave the Preferences dialog open or **Cancel** to close the Preference dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the settings each time you join another session on the same computer.
The Activity Window

The Activity Window is a stand-alone window in Blackboard Collaborate Web Conferencing that reports various events that take place in Blackboard Collaborate through the duration of a session. The window has a simple design so you can use a screen reader to navigate through the user interface and read the events as they occur. The Activity Window also enables you to perform simple functions through a command line interface. The window consists of the following main components:

1. Show/Hide Command Input field
2. Audible Notification Filter
3. Module Event Filter
4. Importance Event Filter
5. Close button
6. Tool bar
7. Event panel
8. Command Input field
The **Tool Bar**, at the top of the window, contains the **Show/Hide Command Input Field** button, the Audible Notifications Filter, the Module Event Filter and the Importance Event Filter. (These are described a little later.)

The **Event Panel**, in the middle of the window, reports the events that have occurred in the session.

The **Command Input Field**, at the bottom of the window, enables you to type commands to perform some basic tasks in Blackboard Collaborate.

### Opening and Closing the Activity Window

Opening and closing the Activity Window is simple so you can access it without your attention being diverted from the session in progress. If you move to a different window in Blackboard Collaborate Web Conferencing, you easily can bring the Activity Window back into focus (activate it).

You also can move, resize or close the Activity Window so it is not obtrusive.

---

**Note:** On Windows, Linux and Mac OS X platforms, the Activity Window always remains in front of the Blackboard Collaborate main window. On Solaris, if you click on the main Blackboard Collaborate window, the Activity Window will move behind the main window.

---

To open or activate (bring into focus) the Activity Window, do one of the following:

- Enter the keyboard shortcut Control+/ (Command- / on Mac)
- From the *Window* menu, select *Show Activity* (on Windows or Linux, you can use the mnemonic Alt+W+A to select it)

To close the Activity Window, do one of the following:

- Enter the keyboard shortcut Control+W or Alt+F4 (Command-W on Mac)
- From the *Window* menu, select *Show Activity* (on Windows or Linux, you can use the mnemonic Alt+W+A to select it)
- Click on the **Close** button in the top-right corner of the window

### Displaying Events

Notable events that occur in an Blackboard Collaborate Web Conferencing session are displayed in the Event panel of the Activity Window. By default, events of all Blackboard Collaborate modules are displayed and the approximate time each event occurred is noted. Moderators can see all events and Participants can see only a subset of events.
When a new event is reported, keyboard focus stays at the last place you had it (the last cursor position is maintained and the window will not scroll to the new message at the bottom). You need to manually move focus to the new event using your arrow keys or scroll bar so you can read the new text.

---

**Note:** The complete list of events is shown in the Event Filtering Preferences panel. (For details, refer to *Event Filtering Preferences Panel* on page 42.)

---

You can manage your display in three ways:

- Filter which events are to be displayed in the event panel (see *Filtering Events for Display* below).
- Change the text size in the event panel (see *Resizing Activity Window Text* on page 44).
- Show or hide the time stamps associated with events (see *Showing/Hiding Time Stamps* on page 44).

---

**Tip:** Although there is no Save or Export function in the Activity Window, if you want to save a history of the activity, simply copy and paste the events into a text editor.

---

**Filtering Events for Display**

You can select which events you want displayed in your own Event panel through the Module Event Filter and the Importance Event Filter menus in the Activity Window or through the Event Filtering preferences panel.

---

**Note:** The events you hide or display will affect what is displayed in your own Event panel only – it will not affect what others see in their own Event panels.

---

You can select which events for which you want to be audibly notified through the Audible Notifications Filter in the Activity Window or through the Audible Notifications Preferences panel.

**Audible Notifications Filter**

Audible notifications are system messages sent by Blackboard Collaborate Web Conferencing to notify users when certain important events occur within the session. These notifications are presented as sounds.
To open the Audible Notifications Filter menu, click on the **Audible Notification Filter** button in the toolbar. You can specify which set of audible notifications you would like to hear (all, basic or custom) from the Audible Notifications Filter. These are the same set of notifications you can configure in the Audible Notifications Preferences panel. See *Audible Notifications* on page 61 for details.

*Custom Audible Notifications* are the set of individual notifications that you selected in the Audible Notifications Preferences panel, rather than selecting *All* or *Basic*.

---

**Note:** The filtering options set in the Audible Notifications Filter are reflected in the Audible Notifications Preferences panel. Likewise, if you make a change to the options in the Audible Notifications Preferences panel, you will see these changes in the Audible Notifications Filter as well.

---

**Module Event Filter**

The Module Event Filter is used to include or exclude all events associated with a particular Blackboard Collaborate module. By default, all modules are included.

---

**Note:** The filtering options set in the Event Filtering Preferences panel always override the filtering set in Module Event Filter.

To open the Module Event Filter menu, click on the **Module Event Filter** button in the toolbar. To exclude events of a module, de-select the module name from the menu: Activity (messages related to the commands you enter in Command input field, such as usage tips and error messages), Application Sharing, Audio, Chair, Chat, File Transfer, Interaction, Multimedia, Participants, Quiz Manager, Recorder, Timer, Video and Whiteboard.

To turn display of a module’s events back on, select the module name again.

---

**Note:** To display some but not all events associated with a module, use the Event Filtering Preferences panel. For details, refer to *Event Filtering Preferences Panel* on page 42.
Importance Event Filter

The Importance Event Filter is a menu that enables you to filter events based on what is important or relevant. It also has an option to turn off/on the time stamps that appear in the Event panel.

Note: Hide Notifications and Hide My Events operate independently from All Events, Common Events and Important Events. For example, if you hide your own events, they will not be displayed even if you have selected All Events.

Note: You can pick only one of All Events, Common Events or Important Events.

To open the Importance Event Filter menu, click on the Importance Event Filter button in the tool bar. The menu has the following options:

- **Show Notifications** – Notifications are system messages sent by Blackboard Collaborate to alert users when certain events occur: user joined or left the session, Moderator privileges granted, Timer expired and Chat announcement sent or received. By default, notifications will be displayed in your Event panel. If you don’t want Notifications displayed in your Event panel, select Hide Notifications. The menu item will change to Show Notifications; select this to turn display of Notifications back on.

  Note: The Hide/Show Notifications option affects what is displayed in your Event panel only. It will not affect whether or not a Visual Notification is shown in its own floating window; that is set in the Visual Notifications Preferences panel (see Visual Notifications on page 63). Conversely, what is set in the Visual Notifications Preferences panel will not affect what is displayed in the Event panel.

- **Show My Events** – By default, the events that you triggered (e.g., raise your hand or turn on your microphone) will not be displayed in your Event panel. (They may, however, be displayed in the event panel of others, depending on the event.) If you want to display these events in your own Event panel, select Show My Events. The menu item will change to Hide My Events; select this to turn display of your events back off.

- **All Events** – By default, events of all importance are displayed in the Event panel. If you don’t want to see all events, select either Common Events or Important Events.
- **Common Events** – Select this option to display all events except the interaction events: Raise Hand/Lower Hand, Stepped Away/Came Back buttons and the emoticons Laughter, Applause, Confusion and Disapproval.

- **Important Events** – Select this option to display only a small subset of events, such as when a user has joined a session, when you have been granted the Moderator privilege or when you have received a Chat message.

- **Hide Times** – Select this option to turn off/on the time stamps that appear in the Event panel. For further details, see *Showing/Hiding Time Stamps on page 44*

**Event Filtering Preferences Panel**

If you want to filter events at a greater level of granularity than is offered by the Module Event Filter, you can do so in the Event Filtering Preferences panel. Here you can pick and choose which individual events in a particular module you want to be displayed in the Event panel.

1. Open the Preferences dialog in one of the following ways:
   - From the Edit menu, select Preferences... (Windows & Linux)
     - From the Blackboard Collaborate Web Conferencing menu, select Preferences (Mac OS X)
   - Enter Ctrl+Comma (Windows & Linux)
     - Enter Command-Comma (Mac OS X)
2. In the left pane of the Preferences dialog, under Activity select Event Filtering. The Event Filtering preferences panel appears. The events are listed according to the module to which they belong. Each event has a drop-down menu from which you can select the option to display the event Normally, Always or Never.

3. Select the desired option for each of the events listed under the module names. Normally is the default option.

**Note:** The filtering set in the Event Filtering Preferences panel always overrides the filtering set in the Activity Window menus. For example, if you turn off the Audio module events in the Activity Window but have Microphone turned on set to display Always in the Preferences panel, whenever you turn on your microphone in the session, the event will be reported in the Events panel.

- **Normally** – Select this option if you would like to use the filtering defined by the Activity Window’s Module and Importance Event Filters.
- **Always** – Select this option if you would like to always display this event, even if it has been excluded from display by the Activity Window’s Module and Importance Event Filters.
- **Never** – Select this option if you would like to never display this event, even if it has been included for display by the Activity Window’s Module and Importance Event Filters.
4. Click on **OK** to save your preferences and close the Preferences dialog, **Apply** to save your preferences and leave the Preferences dialog open or **Cancel** to close the Preferences dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the settings each time you join another session on the same computer.

**Resizing Activity Window Text**

By default, the text in the Activity Window is determined by your operating system (typically 10 or 11 points).

- **To make the text larger**, right-click (Control-Click on Mac) anywhere in the Activity Window to open the context menu and select *Make Text Bigger*.
- **To make the text smaller**, right-click (Control-Click on Mac) anywhere in the Activity Window to open the context menu and select *Make Text Smaller*.
- **To return the text to the default size**, right-click (Control-Click on Mac) anywhere in the Activity Window to open the context menu and select *Default Size*.

**Showing/Hiding Time Stamps**

By default, the Event panel displays a time stamp every 5 minutes. Any events that occur in the next five minute period will appear beneath that time stamp in the Event panel. For example, a time stamp will be reported at 1:00 PM and any events that occur between 1:00 PM and 1:05 PM will be listed beneath the 1:00 PM time stamp. If there is no activity in a 5 minute period, (for example, between 1:05 PM and 1:10 PM), no time stamp will be reported for that period (for example, 1:05 PM will not be reported). (This scenario is illustrated in the left screen capture below.) The next time stamp displayed will be for the next five minute period in which events occurred.
If you want to hide the time stamps in the Event panel, select Hide Time from the Importance Event Filter. The menu item will change to Show Times; select this to turn the display of times back on. (The right screen capture above shows the Activity Window with time stamps hidden.)

**Reading Events with a Screen Reader**

A screen reader will not automatically read an event as it appears in the Activity Window. To be notified that an event has just been added to the Activity Window, turn on the Audible Notification *Activity Event Occurred*. (For instructions, see Audible Notifications on page 61.)

When a new event is reported, keyboard focus stays at the place you last had it (the last cursor position is maintained and the window will not scroll to the new message at the bottom). You need to manually move focus to the new event using your arrow keys so your screen reader can read the new text.

**Entering Commands**

The Activity Window enables you to perform simple functions through the Command Input field. This field is normally hidden.

To enter a command, do the following:

1. Open the Command Input field in one of the following ways:
   - Click on the Show/Hide Command Input field button in the tool bar.
     
     Note: The field will remain open until you click on the Show/Hide Command Input field button again.
   - Type / (forward slash). The /, which is the first character required to enter a command, will be entered into the Command Input field.
     
     Note: The field will close after you have entered your command and pressed Enter or Return.

2. Enter a / (if not already there) followed by your command. For a list of the commands and their syntax, refer to Live Session Commands on next page and Recording Playback Command on page 47.

3. Press Enter or Return to process the command.

If the command is unknown, has an unknown or invalid parameter or an error occurs while processing the command, a message to that effect will be displayed in the Event panel. If the command is successful, nothing is displayed.
Note: After the command has been processed, focus returns to the Event panel.

Tip: The Command Input field can be resized, if desired, by dragging the divider between it and the Event panel with your mouse.

Live Session Commands
These commands can be used only in a live session, not while listening to a recording.
Each command starts with a / (forward slash) and is followed by parameters. Where there is more than one available parameter, they are listed together and separated by a | (pipe). Enter only one parameter.

Raise or Lower Hand
Syntax: /hand up|down

Set Audio Mode
Syntax: /audio computer|phone

Talk or Stop Talking
Syntax: /talk on|off

Send Chat Message
Syntax:
/chat <message>
where
- <message> is the text of your message

Note: use this syntax to send a public message to only the room you are currently in.
or
/chat [@<recipient> | @all_rooms | @announcement | @moderators] <message>
where

- <recipient> sends a private message to the specified Moderator or Participant
- all_rooms sends a public chat to all rooms (Main room and breakout rooms)
- announcement sends a public message as an Announcement
- moderators sends a message to Moderators only (under the Moderators conversation tab)

These options are **not** case-sensitive.

---

**Tip:** Enclose <recipient> in quotation marks if it contains an ambiguous term. For example, let's say there are two Participants, one named Mary and one named Mary Hansen. If you want to send Mary Hansen the message “Hello Mary”, enclose her name in quotation marks:

/chat @“Mary Hansen” Hello Mary

If you enter

/chat @Mary Hansen Hello Mary

you will send the other Mary the message “Hansen Hello Mary”.

---

<message> is the text of your message.

**Display Video**

*Syntax:* /video preview|on|off

**React** (show emotion)

*Syntax:* /react laughter|applause|confusion|disapproval|approval|faster|slower

**Enter Polling Response**

*Syntax:* /answer none|yes|no|a|b|c|d|e

**Step Away or Come Back**

*Syntax:* /status away|back

**Recording Playback Command**

This command can be used only while listening to a recording. It starts with a / and is followed by one of three parameters, listed together and separated by a | (pipe). Enter only one parameter.

*Syntax:* /playback start|pause|stop
Chapter 5

Closed-Captioning

The Closed-Captioning feature enables a session attendee to transcribe audio information while a session is in progress. The transcribed text can be viewed by other session attendees in the live session and in a recording of the session. It can also be saved to a text file.

There are two types of Closed-Captioning windows: one for entering closed-captioning text (input window) and one for reading the text (view-only window).

Note: Closed-Captioning windows always stay on top of other windows so they are easily accessed.

Anyone in the session can view the closed-captioning text, but a Moderator must give session attendees the permission to enter closed-captioning text. More than one person may be given permission to enter closed-captioning text.
Closed-Captioning Activity and Permission Indicators

You can monitor the state of Closed-Captioning activity and permissions through indicators displayed in the Participants list of the Participants panel.

The following table describes the icons displayed in the Participant list to indicate Moderator and Participant permissions and activity while using Closed-Captioning.

<table>
<thead>
<tr>
<th>Activity Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🏷️</td>
<td>User is currently entering Closed-Captioning text.</td>
</tr>
<tr>
<td>🎥️</td>
<td>Moderator has granted Closed-Captioning permission to this user.</td>
</tr>
</tbody>
</table>

Entering Closed-Captioning Text

Once you have been given permission to enter the closed-captioning text, open the Closed-Captioning input window by doing one of the following:

- Click on the 🏷️ **Closed-Captioning** button at the top of the Audio & Video panel.

- From the Window menu, select Show Closed-Captioning.

Place your cursor in the input window (below [Enter captions text]) and start typing (or paste text).

The Closed-Captioning window also enables you to do the following:

- change window display options (see *Window Display Options* on page 53)
- save the closed-captioning text (see *Saving Closed-Captioning Text* on page 52)
Viewing Closed-Captioning Text

All Moderators and Participants, upon joining a session have the permission to view the text in the Closed-Captioning window. To open the Closed-Captioning view-only window, do one of the following:

- Enter Control+F8 (Command-F8 on Mac).
- From the Window menu, select Closed-Captioning.
- If someone in the session has been granted the permission to enter captions, you will see the Closed-Captioning button at the top of your Audio & Video panel. Click on it to open the view-only window.

If no one is currently entering closed-captioning text, the Closed-Captioning window will state [No caption source available].

If someone is entering closed-captioning text, the Closed-Captioning window will display who is entering the Closed-Captioning text in the Source menu. In the example below, Lucy entered the text.

[Using captions from Lucy]
This is some text entered by Lucy.

Note: The view window keeps a history of the captions. If you close and reopen it, it will retain the captions that you received when the window was previously open. It will not, however, display any captions entered by a captioner while you had the window closed.
The Closed-Captioning window enables you to do the following:

- read closed-captioning text;
- change the closed-captioning source (see Viewing Closed-Captioning Text on page 51);
- change window display options (see Window Display Options on page 53);
- save the closed-captioning text (see Saving Closed-Captioning Text on page 52).

**Changing the Closed-Captioning Source**

If more than one person in the session is entering closed-captioning text at the same time during the session, all their names will appear in the Preferred Source drop-down menu. To change whose closed-captioning text you want to read, click on the drop-down arrow button and then select the desired person.

If the source is set to None (such as when you first open the view-only Closed-Captioning window), the first person who starts entering closed-captioning text automatically will become the source.

### Tip:

You also can tell who is currently entering Closed-Captioning text by the presence of the ![Closed-Captioning](image) icon next to the captioners’ names in the Participants list.

If your selected (preferred) captioner leaves the room, you will receive the captions of the next captioner in the list (if there is another captioner). If your preferred captioner returns to the room, you will receive their captions once again.

**Saving Closed-Captioning Text**

You can save the closed-captioning text by selecting Save from the Options menu in either of the Closed-Captioning windows (input or view).

Each time you close the Closed-Captioning window a new transcript is started, so only the captions that were entered since the last time you opened the window will be saved.
Window Display Options

In both Closed-Captioning windows (captioner's input window and reader's view-only window) you can customize the display of the window by changing the font, size and color of the text and the color of the background.

**Note:** Blackboard Collaborate Web Conferencing will remember these setting each time you join a session from the same computer.

The following options are available:

- **Background Color** – To change the background color in the window, click on the Background Color square to open the color picker. The default color is white. The new color you select will be displayed in the square.

- **Text Font** – To change the font of the caption text, click on the Text Font drop-down menu arrow and select the desired font. The default font is Dialog.

- **Text Size** – To change the size of the caption text, click on the Text Size drop-down menu arrow and select the appropriate font size. The default text size is 24.
- **Text Color** – To change the color of the caption text, click on the Text Color square to open the color picker. The default color is black. The new color you select will be displayed in the square.

- **Invert** – To reverse the text and background colors, select Invert from the Closed-Captioning Options menu.

In our current example, the dark blue text will become light blue and the light blue background will become dark blue.

**Closing and Reopening the Closed Captioning Window**

**Input window**: As the writer of captions, when you close the caption input window, it will be cleared of all content. When you reopen it, it will be blank.

**View-only window**: As the reader of captions, when you close the view window, it will keep a history of the captions. When you reopen it, it will contain the captions that you received when the window was previously open. It will not, however, display any captions entered by a captioner while you had the window closed.
To close the window, do one of the following:

- Click on the [Closed-Captioning] button at the top of your Audio & Video panel.
- Click on the window’s Close button in the title bar of the window.
- Enter Ctrl+W (Command-W on Mac)
- Enter Alt+F4 (Windows and Linux only)

To reopen the window, do one of the following:

- Click on the [Closed-Captioning] button at the top of your Audio & Video panel.
- Enter Ctrl+F8 (Command-F8 on Mac).
- From the Window menu, select Closed-Captioning.
Chapter 6

Accessibility Options

Several options and preferences exist in Blackboard Collaborate Web Conferencing to improve accessibility. See the following sections for details:

- *Setting Notification Preferences* on page 61
- *Application Sharing Options* on page 65
- *Changing the Chat Text Size* on page 68
- *Changing the Notes Text Size* on page 70

Managing Audio

The following sections describe the Audio accessibility features.

Using the Audio Setup Wizard

To verify that your Audio is set up correctly, we recommend that you use the Audio Setup Wizard before the session begins. This wizard is comprised of a series of panels that guide you through selecting Audio input (microphone) and output (speaker) devices and setting your speaker and microphone volumes.
**Tip:** To run the Audio Setup Wizard before your session begins, either join your session early or open the Configuration Room on the Blackboard Collaborate Support Portal:

http://support.blackboardcollaborate.com

To open the Configuration Room, browse to First Time Users and then to Step 2 under Blackboard Collaborate Web Conferencing.

You can run the Audio Setup Wizard again at any time within your session.

---

**Note:** When you are using the Audio Setup Wizard during a session, you will not be able to hear any of the session audio. Others will know you can’t hear them because the Audio Setup Wizard icon 🌟 will appear next to your name in the Participants list.

To open the Audio Setup Wizard, do one of the following:

- Click on the Audio Setup Wizard button at the top of the Audio & Video panel.

- From the **Tools** menu select **Audio** and then **Audio Setup Wizard**.

- From the Audio & Video Options menu, select **Audio Setup Wizard**.

**On Windows or Linux**

1. Select your audio output device (speakers), following the instructions given in the dialog box.

2. Play the recorded audio message provided and adjust your speaker volume to a suitable level. (Follow the instructions given in the dialog box.)

3. Confirm whether or not your speaker was set to an appropriate level.
   - If you clicked on **Yes**, go to step 4.
   - If you clicked on **No**, you are prompted to try again or cancel. Click on **Try Again** to go back to step 1.

4. Select an audio input device (microphone), following the instructions given in the dialog box.

5. (Linux only) Select your microphone type to get the best results when testing your microphone.
   - **Single Talker**: Select this option if using a headset or a microphone just for yourself.
   - **Multiple Talkers**: Select this option if using a single microphone to pick up multiple talkers, such as when you are in meeting room sharing the microphone with others. This is the default.
6. Press **Record** and adjust your microphone recording level as you speak into the microphone (audio input device). (Follow the instructions given in the dialog box.) Press **Stop** when you are done.

7. Press **Play** to listen to the recording you just made and, based on the loudness and clarity of the recording, determine if your microphone was set to an appropriate level.

8. Confirm whether or not your microphone was set to an appropriate level.
   - If you clicked on **Yes**, go to step 8.
   - If you clicked on **No**, you are prompted to try again or cancel. Click on **Try Again** to go back to step 4.

9. Read the message in the dialog box and click on **OK** to complete Audio setup and exit the Audio Setup Wizard.

### On Mac OS X

1. Mac users cannot change their audio output (speaker) devices directly in Blackboard Collaborate Web Conferencing – Blackboard Collaborate uses the system default device. To change your output device, click on the speaker icon in the Select Audio Output Device dialog of the Audio Setup Wizard and make your changes in the System Preferences Sound Output panel. When done, click on **OK** to advance to the next panel of the wizard.

2. Play the recorded audio message provided and adjust your speaker (audio output device) volume to a suitable level. (Follow the instructions given in the dialog box.)

3. Confirm whether or not your speaker was set to an appropriate level.
   - If you clicked on **Yes**, go to the next step.
   - If you clicked on **No**, you are prompted to try again or cancel. Click on **Try Again** to go back to step 1.

4. Select an audio input (microphone) device from the list or select the option **Use System Default Device**. Follow the instructions given in the dialog box.

5. (Mac OS X 10.5 and earlier only) Select your microphone type to get the best results when testing your microphone.
   - **Single Talker**: Select this option if using a headset or a microphone just for yourself.
   - **Multiple Talkers**: Select this option if using a single microphone to pick up multiple talkers, such as when you are in meeting room sharing the microphone with others. This is the default.

6. Press **Record** and adjust your microphone recording level as you speak into the microphone (audio input device). (Follow the instructions given in the dialog box.) Press **Stop** when you are done.

7. Press **Play** to listen to the recording you just made and, based on the loudness and clarity of the recording, determine if your microphone was set to an appropriate level.
8. Confirm whether or not your microphone was set to an appropriate level.
   - If you clicked on Yes, go to the next step.
   - If you clicked on No, you are prompted to try again or cancel. Click on Try Again to go back to step 3.
9. Read the message in the dialog box and click on OK to complete Audio setup and exit the Audio Setup Wizard.

### Adjusting Microphone and Speaker Levels

The microphone level indicator (microphone icon) shows the volume levels when you are speaking and the speaker level indicator (speaker icon) shows the volume levels when someone else is speaking.

**Tip:** If all talkers have their microphones set properly, listeners won’t need to keep adjusting their speakers to accommodate changes in volume. The best way to ensure proper microphone and speaker levels is to run the Audio Setup Wizard at the beginning of the session. See Using the Audio Setup Wizard on page 57.

### Microphone Level

There are four ways to adjust your microphone level:

- **Audio & Video panel:** Grab the microphone level slider in the Audio & Video panel and drag it to the right to increase the volume and to the left to decrease the volume.

- **Options menu:** From Audio & Video Options menu, select either Adjust Microphone Level Up (to increase the volume) or Adjust Microphone Level Down (to decrease the volume).

- **Tools menu:** From the Tools menu, select Audio and then select either Adjust Microphone Level Up (to increase the volume) or Adjust Microphone Level Down (to decrease the volume).

- **Keyboard Shortcuts:** Enter Ctrl+Shift+Up Arrow (Shift-Command-Up Arrow on Mac) to increase the volume or Ctrl+Shift+Down Arrow (Shift-Command-Down Arrow on Mac) to decrease the volume.
**Speaker Level**

There are four ways to adjust your speaker level:

- **Audio & Video panel:** Grab the speaker level slider in the Audio & Video panel and drag it to the right to increase the volume and to the left to decrease the volume.

- **Options menu:** From Audio & Video Options menu, select either *Adjust Speaker Level Up* (to increase the volume) or *Adjust Speaker Level Down* (to decrease the volume).

- **Tools menu:** From the *Tools* menu, select *Audio* and then select either *Adjust Speaker Level Up* (to increase the volume) or *Adjust Microphone Speaker Down* (to decrease the volume).

- **Keyboard Shortcuts:** Enter Ctrl+Up Arrow (Command-Up Arrow on Mac) to increase the volume or Ctrl+Down Arrow (Command-Down Arrow on Mac) to decrease the volume.

**Setting Notification Preferences**

**Audible Notifications**

Audible notifications are system messages sent by Blackboard Collaborate Web Conferencing to notify users when certain important events occur within the session. These notifications are presented as sounds.

---

**Note:** The implementation of audible notifications on mobile devices is different than what is described here. For a list of features supported on mobile devices, see the *Moderator's Guide*.

---

In the Preference dialog, you can listen to what each notification sounds like as well as enable or disable the notifications. There are two built-in sets of notifications: Basic and All.
1. Open the Preferences dialog in one of the following ways:
   - From the Edit menu, select Preferences... (Windows & Linux)
     From the Blackboard Collaborate Web Conferencing menu, select Preferences (Mac OS X)
   - Enter Ctrl+Comma (Windows & Linux)
     Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, under General select Audible Notifications. The Audible Notifications preferences panel appears on the right side of the main Preferences dialog.

   ![Preferences dialog](image)

3. To hear the sound used for a notification, click on its Preview icon 🎧 in the right column of the panel.

4. Enable and disable the notifications for the various events in the following ways.
   - To create a custom set of notifications, click on the Enabled checkbox (middle column) associated with the desired individual events.
   - Click on the Basic button at the bottom of the panel to select the Hand Raised Alarm, Recording in Progress, Start Recording, Stop Recording and Timer Alarm events. This is the default setting.
   - Click on the All button at the bottom of the panel to select all events.
5. Click on OK to save your preferences and close the Preferences dialog, Apply to save your preferences and leave the Preferences dialog open or Cancel to close the Preference dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the settings each time you join another session on the same computer.

**Visual Notifications**

Visual notifications are system messages sent by Blackboard Collaborate Web Conferencing to alert users when certain important events occur within a session. These notifications are presented in a floating window. Multiple notifications get queued: the first one is displayed until it times out or you dismiss it (by clicking on the **Dismiss** button in the bottom right corner of the notification), then the next one is displayed, and so on. When there is more than one notification, the window will have a **Dismiss All** button beside the **Dismiss** button and display the number of notifications in the queue in the bottom left corner of the notification.

---

**Note:** The implementation of visual notifications on mobile devices is different than what is described here. For a list of features supported on mobile devices, see the *Moderator’s Guide*.

You can judge how long the message will remain open by looking at the Timeout Indicator. You either can dismiss a notification manually (by clicking on the **Dismiss** button) or wait for it to close itself automatically (when the Timeout Indicator runs its course).

<table>
<thead>
<tr>
<th>Carlo joined session.</th>
<th>1:45 PM</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong> Timeout Indicator</td>
<td>2 notifications</td>
</tr>
<tr>
<td><strong>2</strong> Number of notifications in the queue</td>
<td><strong>3</strong> Dismissal buttons</td>
</tr>
</tbody>
</table>

In the Preference dialog, you can enable or disable the notifications. By default, all notifications are enabled.

1. Open the Preferences dialog in one of the following ways:
   - From the **Edit** menu, select *Preferences...* (Windows & Linux)
   - From the Blackboard Collaborate Web Conferencing menu, select *Preferences* (Mac OS X)
   - Enter Ctrl+Comma (Windows & Linux)
   - Enter Command-Comma (Mac OS X)
2. In the left pane of the Preferences dialog, select Visual Notifications under General. The Visual Notifications preferences panel appears on the right side of the main Preferences dialog.

3. Enable and disable the notifications for the various events as desired by selecting/deselecting the checkboxes in the Enabled column on the right side of the panel.

   **Note:** The changes you make in the Visual Notifications Preferences panel will not affect what is displayed in the Event panel of the Activity Window.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save your preferences and leave the Preferences dialog open or Cancel to close the Preference dialog without saving any of your changes.
When you configure preferences, Blackboard Collaborate Web Conferencing will remember the settings each time you join another session on the same computer.

**Application Sharing Options**

The following sections describe Application Sharing features that improve accessibility for low vision and color blind users.

**Viewing a Shared Application**

Application Sharing is displayed in the Content area, which contains an Application Sharing Action bar in the upper left corner. For Participants without the Application Sharing permission, the bar contains the Scale to Fit option only (see Viewing a Shared Application above).

Participants who have the Application Sharing permission have the additional option Request Cursor Control. For information on this feature refer to Requesting Control of an Application Share from the Host.

**Scaling the Shared Content**

The application or desktop area shared by the Host can be scaled to fit the Content area (the default) or viewed at its native size (same size as the Host).

To view the content at the same size as the Host, do one of the following:

- Uncheck Scale To Fit in the Action bar.
- From the Tools menu, select Application Sharing and then uncheck Scale to Fit.

To restore scaling, recheck Scale To Fit.

**Maximizing the Content Area**

Another option you have for viewing an Application Share is to resize the Content area.

You can optimize the space available in the Content area in two ways; for maximum space, do both:

- Maximize your Blackboard Collaborate Web Conferencing window.
- Hide the side bar (Audio & Video, Participants and Chat panels) by unselecting Show Side Bar in the View menu or by grabbing the border of any one of the panels and dragging it all the way to the left.

To restore the side bar, reselect Show Side Bar or drag the panel border back to the right.
**Emphasized Cursor**

If the application host has turned on the option *Emphasize Cursor*, you will see their cursor surrounded with a circle (the default color is yellow), making it easier for you to follow.

![Emphasized Cursor Example](image)

**Hosting Options**

The Hosting Options dialog box allows you to define how to display the Blackboard Collaborate Web Conferencing Application Sharing window while you are hosting an Application Sharing session.

To change the Hosting Options in the Preferences dialog, do the following:

1. Open the Preferences dialog in one of the following ways:
   - From the *Edit* menu, select *Preferences...* (Windows & Linux)
   - From the Blackboard Collaborate Web Conferencing menu, select *Preferences* (Mac OS X)
   - Enter Ctrl+Comma (Windows & Linux)
   - Enter Command-Comma (Mac OS X)
2. In the left pane of the Preferences dialog, select Hosting Options under Application Sharing. The Hosting Options preferences panel appears.

3. Change any options:
   - **Hide content area** – Select this option to collapse the Content area of the Blackboard Collaborate interface, leaving only the sidebar visible.
   - **Shared region highlight color** – Use this option to set the color of the border surrounding your shared application. The border identifies what is being shared so you will always know what the viewers of your application share are seeing.
   - **Raise shared applications to front** – Select this option if you want the application that is being shared to be brought to the front of all other windows. If the option is not selected, the application may be hidden behind other windows on your monitor and the Application Sharing window will be black.

   **Linux Note:** This option does not work on Linux using KDE or Gnome.

   - **Emphasize cursor** – Select this option if you would like the cursor in your shared application to stand out so it is easier for viewers of the shared application to follow its movements. If set, the viewer’s cursor will be surrounded by a colored circle. (As host, your view of the cursor is not emphasized.) Click the colored box to the right to change the highlighter color.

   - **Show a notification** – Select this option if you want a Notification window to appear on your monitor every time you start hosting an Application Sharing session. If you wish not to have this window appear, de-select this option.
4. Click on **OK** to save your preferences and close the Preferences dialog, **Apply** to save your preferences and leave the Preferences dialog open or **Cancel** to close the Preference dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate Web Conferencing will remember the settings each time you join another session on the same computer.

**Chat Options**

The following sections describe the Chat features that improve accessibility for low vision and blind users.

**Changing the Chat Text Size**

You can set the font size of the text in the conversation pane anywhere from 7 points to 109 points, in increments of 2 points. The default value is 13 points, which may be influenced by your system-wide font defaults.

To increase the font size, do one of the following

- From the *Tools* menu, select *Chat* and then *Increase Font Size*.
- From the Chat Options menu, select *Increase Font Size*.

To decrease the font size, do one of the following

- From the *Tools* menu, select *Chat* and then *Decrease Font Size*.
- From the Chat Options menu, select *Decrease Font Size*. 
Adding Emoticons to your Chat Message

Emoticons are special graphical icons that you can insert into any text-based chat to make your conversations more expressive and fun.

You can add emoticons to your Chat messages by selecting them from the Chat Emoticon menu or by entering text strings in the Chat message text field. The text string equivalent of the emoticon selected in the Emoticon menu is displayed in the bottom left corner of the menu.

The following table lists a few of the most popular emoticons and their respective text strings. (A full list of the text strings used for entering emoticons is available in .)

<table>
<thead>
<tr>
<th>Emotions</th>
<th>Icons</th>
<th>Text strings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smiley</td>
<td>😊</td>
<td>:) or :-)</td>
</tr>
<tr>
<td>Wink</td>
<td>😉</td>
<td>;) or ;-)</td>
</tr>
<tr>
<td>Sad</td>
<td>😞</td>
<td>:( or :-(</td>
</tr>
<tr>
<td>Surprised</td>
<td>😮</td>
<td>:-o or :-O</td>
</tr>
<tr>
<td>Confused</td>
<td>😞</td>
<td>:/ or :-/</td>
</tr>
<tr>
<td>Grin</td>
<td>😃</td>
<td>:D or :-D</td>
</tr>
<tr>
<td>Angry</td>
<td>😡</td>
<td>:@ or :-@</td>
</tr>
<tr>
<td>Thumbs up</td>
<td>👍</td>
<td>(y)</td>
</tr>
<tr>
<td>Thumbs down</td>
<td>🙄</td>
<td>(n)</td>
</tr>
</tbody>
</table>

Note: The emoticon text strings are case insensitive, so you can use either upper case or lower case letters to enter your emoticons.
Changing the Notes Text Size

You can change the size of the text displayed in the Notes editor to make it more readable for you. The font size of the entire document will change and any changes that were made using the Decrease and Increase keyboard shortcuts will be overridden.

The available text sizes are 8, 9, 10, 11, 12, 13, 14, 15, 16, 18, 20, 22, 24, 28, 32 and 36 points. To change the font size of the text, do one of the following:

- Select the font size from the Text Size menu in the tool bar of the Notes window.
- Right click (Control-Click on Mac) anywhere in the Notes editor and select one of the options from the context menu.
  - *Make Text Bigger* – increase the text size to the next larger size. For example, if the text was set to 12, selecting Make Text Bigger will increase the size to 13.
  - *Make Text Smaller* – decrease the text size to the next smaller size. For example, if the text was set to 36, selecting Make Text Smaller will decrease the size to 32.
  - *Default Size* – set the text size back to the default setting of 12. (This value may be different for non-English implementations of Blackboard Collaborate Web Conferencing.)
  - *Text Size* – change the text size to that selected from the submenu.
Appendix A:

Chat Emoticon Text Strings

The following table shows the text strings that can be used to enter emoticons. The emoticon text strings are not case sensitive, so you can use either upper case or lower case letters to enter your emoticons.

<table>
<thead>
<tr>
<th>Emotions</th>
<th>Icons</th>
<th>Text strings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smiley</td>
<td>😊</td>
<td>:) or :-()</td>
</tr>
<tr>
<td>Wink</td>
<td>😊</td>
<td>;) or ;-)</td>
</tr>
<tr>
<td>Sad</td>
<td>😞</td>
<td>:( or :-()</td>
</tr>
<tr>
<td>Eye roll</td>
<td>😞</td>
<td>(re)</td>
</tr>
<tr>
<td>Cool (shades)</td>
<td>😎</td>
<td>B) or B-)</td>
</tr>
<tr>
<td>Tongue (sticking out)</td>
<td>😛</td>
<td>:P or :-P</td>
</tr>
<tr>
<td>Surprised</td>
<td>😲</td>
<td>:O or :-O</td>
</tr>
<tr>
<td>Crying</td>
<td>😞</td>
<td>:'(</td>
</tr>
<tr>
<td>Confused</td>
<td>😞</td>
<td>:/ or :-/</td>
</tr>
<tr>
<td>Emotions</td>
<td>Icons</td>
<td>Text strings</td>
</tr>
<tr>
<td>------------------</td>
<td>-------</td>
<td>--------------</td>
</tr>
<tr>
<td>Grin</td>
<td>😊</td>
<td>:D or :-D</td>
</tr>
<tr>
<td>Angry</td>
<td>😞</td>
<td>:@ or :-@</td>
</tr>
<tr>
<td>Evil grin</td>
<td>😈</td>
<td>(6)</td>
</tr>
<tr>
<td>Kiss (lips)</td>
<td>😘</td>
<td>:* or :-*</td>
</tr>
<tr>
<td>Heart</td>
<td>❤</td>
<td>&lt;3</td>
</tr>
<tr>
<td>Broken heart</td>
<td>💔</td>
<td>&lt;/3</td>
</tr>
<tr>
<td>Lightening</td>
<td>⚡</td>
<td>(shazam)</td>
</tr>
<tr>
<td>Report</td>
<td>📑</td>
<td>(p)</td>
</tr>
<tr>
<td>Email (envelope)</td>
<td>📧</td>
<td>(e)</td>
</tr>
<tr>
<td>Open book</td>
<td>📘</td>
<td>(s)</td>
</tr>
<tr>
<td>Book</td>
<td>📘</td>
<td>(ns)</td>
</tr>
<tr>
<td>Chart</td>
<td>📊</td>
<td>(#)</td>
</tr>
<tr>
<td>Clock</td>
<td>🕒</td>
<td>(+)</td>
</tr>
<tr>
<td>Coffee</td>
<td>☕</td>
<td>(c)</td>
</tr>
<tr>
<td>Birthday cake</td>
<td>🎂</td>
<td>(hb)</td>
</tr>
<tr>
<td>Telephone</td>
<td>📱</td>
<td>(t)</td>
</tr>
<tr>
<td>Television</td>
<td>📺</td>
<td>(tv)</td>
</tr>
<tr>
<td>Music (notes)</td>
<td>🎶</td>
<td>(m)</td>
</tr>
<tr>
<td>Computer</td>
<td>🌐</td>
<td>(01)</td>
</tr>
<tr>
<td>iPod</td>
<td>🎁</td>
<td>(i)</td>
</tr>
<tr>
<td>Game (controller)</td>
<td>🎮</td>
<td>(g)</td>
</tr>
<tr>
<td>Webcam</td>
<td>📯</td>
<td>(w)</td>
</tr>
<tr>
<td>Bat</td>
<td>🦇</td>
<td>[:</td>
</tr>
<tr>
<td>Man</td>
<td>🧵</td>
<td>(z)</td>
</tr>
<tr>
<td>Woman</td>
<td>🧵</td>
<td>(x)</td>
</tr>
<tr>
<td>Group (of people)</td>
<td>🧵</td>
<td>(f)</td>
</tr>
<tr>
<td>Emotions</td>
<td>Icons</td>
<td>Text strings</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
<td>--------------</td>
</tr>
<tr>
<td>Credit card</td>
<td>🛒</td>
<td>(cc)</td>
</tr>
<tr>
<td>Money (dollar bill)</td>
<td>💸</td>
<td>($)</td>
</tr>
<tr>
<td>Alert (caution sign)</td>
<td>⚠️</td>
<td>(!)</td>
</tr>
<tr>
<td>Eye</td>
<td>👀</td>
<td>(eye)</td>
</tr>
<tr>
<td>Car</td>
<td>🚗</td>
<td>(a)</td>
</tr>
<tr>
<td>Male (symbol)</td>
<td>♂</td>
<td>(xy)</td>
</tr>
<tr>
<td>Female (symbol)</td>
<td>♀</td>
<td>(xx)</td>
</tr>
<tr>
<td>Soccer ball</td>
<td>⚽</td>
<td>(1)</td>
</tr>
<tr>
<td>Football</td>
<td>🏈</td>
<td>(2)</td>
</tr>
<tr>
<td>Basketball</td>
<td>🏀</td>
<td>(3)</td>
</tr>
<tr>
<td>8 Ball</td>
<td>⚛️</td>
<td>(8)</td>
</tr>
<tr>
<td>House</td>
<td>🏡</td>
<td>(h)</td>
</tr>
<tr>
<td>Sleep (ZZZs)</td>
<td>🉬</td>
<td>(zz)</td>
</tr>
<tr>
<td>Thumbs down</td>
<td>👎</td>
<td>(n)</td>
</tr>
<tr>
<td>Thumbs up</td>
<td>👍</td>
<td>(y)</td>
</tr>
<tr>
<td>Sun</td>
<td>☀️</td>
<td>(su)</td>
</tr>
<tr>
<td>Cloud</td>
<td>⛅️</td>
<td>(ts)</td>
</tr>
<tr>
<td>Rain</td>
<td>⛈️</td>
<td>(rn)</td>
</tr>
<tr>
<td>Snow</td>
<td>☃️</td>
<td>(sn)</td>
</tr>
<tr>
<td>Rainbow</td>
<td>🌈</td>
<td>(r)</td>
</tr>
<tr>
<td>Star</td>
<td>⭐️</td>
<td>(*)</td>
</tr>
</tbody>
</table>
Copyright

This document contains confidential proprietary information and is protected by law. This document and the information contained in it are intended for authorized users only and may be used only for the express purpose of legally accessing and using Blackboard Inc. products; any other use, without Blackboard Inc.’s prior written permission, is strictly prohibited.

© 2012 Blackboard Inc. All Rights Reserved.

Trademarks

Blackboard, the Blackboard logo, Blackboard Collaborate, the Blackboard Collaborate logo, Behind the Blackboard, Wimba and Elluminate are trademarks or registered trademarks of Blackboard Inc. or its subsidiaries in the United States and/or other countries. All rights reserved.

All other brand or product names are trademarks or registered trademarks of their respective companies or organizations.